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Lecture 2/3 
 

Voir la vidéo: https://support.microsoft.com/fr-fr/office/ins%C3%A9rer-une-table-des-

mati%C3%A8res-882e8564-0edb-435e-84b5-1d8552ccf0c0 

Sway : https://youtu.be/NVh--sAzYpU 

a.   

Voir class recording2  (WORD TOC, SWAY, PDF) and hints  (files). 

1. Début : fichier Word 
2. Fin :   Fichier PDF 

Affichez votre résultat comme un fichier nommé word-sway.pdf à l’adresse suivante :  

http://oldtown.glendon.yorku.ca/~nom/final/2915/dec16/word-sway.pdf 

Hint: 

1. Ajoutez des liens à /Créer la table des matières en modifiant le fichier Word (Début) 

2. Comparez-le au fichier PDF souhaitable  et ajoutez les quelques ajouts nécessaires au fichier 

WORD. Votre filigrane devrait être votre « numéro d’étudiant ». Par exemple, « 1237656 ». 

 

b. Trinket  permet d’écrire et d’exécuter des scripts html/css dans un navigateur 

depuis n’importe quel support (ordinateur, tablette...) sans installation préalable.  

 
Thème : LE WEB 

Créer vos propres trinkets 

Le site trinket est vraiment pratique. Voici comment créer les vôtres. 

1 – Créez-vous un compte. 

2 – Créez un nouveau Trinket :  

3 – Créez vos fichiers dans ce trinket et sauvegardez. 

4 – Placez votre trinket dans un Folder (en le créant si besoin) :  

5 – Rajoutez vos images éventuelles avec l'icône indiqué : 

https://support.microsoft.com/fr-fr/office/ins%C3%A9rer-une-table-des-mati%C3%A8res-882e8564-0edb-435e-84b5-1d8552ccf0c0
https://support.microsoft.com/fr-fr/office/ins%C3%A9rer-une-table-des-mati%C3%A8res-882e8564-0edb-435e-84b5-1d8552ccf0c0
https://youtu.be/NVh--sAzYpU
https://yorku.zoom.us/rec/share/L6fZn8XLcd2qwIpc0B--OCut5fY-3YMFvNq4w87seviVBAn6Wqg-Cdh5nujWkHM9.aYFXrrbctBS5qpSx
http://oldtown.glendon.yorku.ca/~teaching/2022/2915/final/exam/hints/November26.pdf
http://oldtown.glendon.yorku.ca/~teaching/2022/2915/dec16/envoi/Andri%20v.%20Iceland%20%5bGC%5d-exam-start.docx
http://oldtown.glendon.yorku.ca/~teaching/2022/2915/dec16/envoi/Andri%20v.%20Iceland%20%5bGC%5d-exam-end.pdf
http://oldtown.glendon.yorku.ca/~teaching/2022/2915/dec16/envoi/Andri%20v.%20Iceland%20%5bGC%5d-exam-start.docx
http://oldtown.glendon.yorku.ca/~teaching/2022/2915/final/word-sway/Andri%20v.%20Iceland%20%5bGC%5d-End.pdf
https://trinket.io/


2 

Itec/MODR 2915 

2 | P a g e  

 

 

6 – Partagez votre dossier en utilisant simplement Share puis Link : 

 

Et voilà : vous venez d'obtenir le lien vers votre page personnelle sur trinket. 

Remarque : Vous pouvez utiliser également une iframe (en utilisant </> Embed) si vous savez stocker 

votre site sur un serveur. Cela permet d'obtenir un écran un peu plus grand. 

 

 

➢ Start: Word file 

➢ End:   PDF file 

Display your result as a file named word-sway.pdf at::  

http://oldtown.glendon.yorku.ca/~lastname/final/2915/dec16/word-sway.pdf 

Hint:  

✓ The given WORD file already has a Table of Contents. 

✓ Add links to the Table of Contents by modifying the Word file (Start). It is helpful to show the 

hidden paragraph break. 

 Compare it to the desirable PDF file and add the few necessary additions to the WORD file. Your 

watermark should be your “student number”. For example, “1237656”. 

http://oldtown.glendon.yorku.ca/~teaching/2022/2915/dec16/envoi/Andri%20v.%20Iceland%20%5bGC%5d-exam-start.docx
http://oldtown.glendon.yorku.ca/~teaching/2022/2915/dec16/envoi/Andri%20v.%20Iceland%20%5bGC%5d-exam-end.pdf
http://oldtown.glendon.yorku.ca/~teaching/2022/2915/dec16/envoi/Andri%20v.%20Iceland%20%5bGC%5d-exam-start.docx
http://oldtown.glendon.yorku.ca/~teaching/2022/2915/final/word-sway/Andri%20v.%20Iceland%20%5bGC%5d-End.pdf
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Insert your 
first table of contents 
Create, update, and customize a table of contents 

You don’t need to wait until your pages are finalized; inserting a table of contents can be an early step in 

creating your document. As the pages of your document develop, Word helps you keep the table of 

contents up to date. 

This doc isn’t just for reading, it’s for trying too. Watch for the Try it text in red throughout this 

document so you can learn by doing. 

Question 1 Insert a table of contents 
To add a TOC (short for table of contents), just decide where you want it. Word will do the heavy lifting.  

Try It: Hit Enter after the first paragraph in this doc to get a new line. Then, go to the References tab, 

select Table of Contents, and choose a TOC from the gallery. 

 

Voila! Word found all the headings in this document and added a TOC. 

Question 2 Update when things change 
The heavy lifting doesn’t stop with creating a TOC. Word is smart enough to keep track of where things 

are, so you don’t have to. When things change, just update the TOC.  
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Try It: Update your TOC. 

1. Place your cursor after the paragraph that ends with, “When things change, just update the TOC” 

(above), and then hit Ctrl+Enter to push this section onto page 3.  

2. Go to your TOC and click anywhere in it. Then click Update Table, and click OK (Update page numbers 

only is selected by default). 

c.  

Word updated the entry for Update when things change from page 2 to page 3.  

Use styles for headings 
The TOC magic is in the styles that are used to format headings. The heading for this section, Use styles 

for headings, might look like a heading, but it doesn’t act like one. It’s formatted in pieces (font size, 

underline) instead of being formatted with a style. See how it’s not in the TOC you added? To add a 

heading to a TOC, it needs to be formatted with the Heading 1 style. 

Try It: Update the style, and then update the TOC. 

1. Click in the heading above (Use styles for headings)—be sure to just click, don’t select anything. 

2. On the Home tab, find Styles, and click Heading 1 (keyboard shortcut: Alt+Ctrl+1). 

3. Update your TOC like you did before, but this time, select Update entire table (instead of Update page 

numbers only) since more than the page numbers changed.  

Now Word knows that paragraph is a heading, and includes it in the TOC.  

Question 3 Dive deeper than Heading 1 
Want more levels in your TOC? That’s where the rest of the Heading styles come in. Mark subheadings 

in your document with Heading 2, lower-level headings with Heading 3, and so on.  

Try It: Apply Heading 2 to the paragraph below (Add a Level 2 TOC entry), and then update your TOC 

like you did before. Remember to update the entire table! 

Add a Level 2 TOC entry  
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Under the hood: Heading styles hold formatting, font, size, color, and more. They also hold a paragraph 

format known as an outline level, which is picked up by the TOC.  

Question 4 Customize your TOC 
The space between an entry and its page number in a TOC is known as a tab leader. By default, Word 

makes the tab leader a row of dots (dot leader), but you can easily switch to something else, like an 

underline. You don’t need to start over—you don’t even need to select the TOC. Word knows where it 

is. Just use the Custom TOC option to make this type of change, and Word will do its thing. 

Try It: Change the dot leader to an underline. 

1. On the References tab, click Table of Contents, and then near the bottom, click Custom Table of 

Contents. 

2. From the list of Tab Leader options, select Line (last choice in the list), and click OK. 

d.   

3. When you’re prompted to replace the TOC, click Yes.  

e.  

And just like that, Word found your TOC and changed the tab leader from dots to an underline.  
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Question 5 Remove a TOC 
You can’t delete a TOC like you can a picture or other things in a doc. Well, you can, but if you do it too 

many times, your TOC can get out of whack. Remember the heavy lifting Word does for you? All the 

scaffolding needs to be removed too. Tell Word to remove the TOC, and Word will clean up after itself.  

Try It: On the References tab, click Table of Contents, and then near the bottom, click Remove Table 

of Contents.  

Poof! The TOC, and the stuff to make it work, are gone from the document. But you can add your TOC 

back any time, in any location. Word will remember everything you did—even your change to the tab 

leader.  

Under the hood: The stuff Word removes is a collection of hidden bookmarks that keep track of the 

heading text and page number shown in the TOC.  

Question 6 Explore more  
If you want to customize your TOC even more, give these a try. (If you didn’t add your TOC back, do 

that now. You can add it above this section if you’d like. Or, if removing it is the last thing you did, 

press Ctrl+Z to undo.)  

Change text formatting of the TOC entries 
Try it:  In your TOC, select an entire Level 1 entry and make a formatting change. For example, change 

the font color to blue. (Make sure you select only one TOC entry, including the tab leader and page 

number. Notice that even though the whole TOC may look like it’s selected, the one entry you select 

will have darker highlighting.) 

 

Like the rest of the TOC magic, all the TOC Level 1 entries changed too.  

Under the hood: Okay, it’s not really magic. The TOC entries are assigned to a style (TOC 1, TOC 2, 

and so on), and those styles are set to update automatically whenever you make a formatting change. 

Change the number of TOC levels 
Try it: Include only Heading 1 headings in your TOC, no subheadings. 

1. On the References tab, click Table of Contents, and then near the bottom, click Custom Table of 

Contents. 
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2. Change Show levels to 1 and click OK. 

f.  

3. When you’re prompted to replace the TOC, click Yes. 

4. Verify your TOC no longer includes subheadings, such as Add a Level 2 TOC entry.  

Question 7 Get help in Word 
The Tell me search box takes you straight to commands and Help in Word. 

 

Try it: Go to Tell me what you want to do near the top of the window, and then type what you want to 

do. 

For example, type: 
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• table of contents to quickly get to the Table of Contents options and other TOC help topics 

• styles if you want to know more about using styles in Word 

• help to go to Word help 

• training to see the list of Word training courses 

 

 

support.microsoft.com  

Insérer une table des matières 

6–8 minutes 

 

Insérer une table des matières 

Word pour Microsoft 365 Word pour Microsoft 365 pour Mac Word pour le web Word 2021 Word 

2021 pour Mac Word 2019 Word 2019 pour Mac Word 2016 Word 2016 pour Mac Word 2013 

Word 2010 Word 2007 Plus...Moins 

Une table des matières dans Word est basée sur les titres de votre document. 

Créer la table des matières 

1. Placez le curseur à l’endroit où vous voulez ajouter la table des matières. 

2. Accédez à Références > Table des matières. et choisissez un style automatique. 

https://support.microsoft.com/fr-fr/office/ins%C3%A9rer-une-table-des-mati%C3%A8res-882e8564-0edb-435e-84b5-1d8552ccf0c0
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3. Si vous apportez des modifications à votre document qui affectent la table des matières, mettez à 

jour la table des matières en cliquant avec le bouton droit sur la table des matières, puis en 

choisissant Mettre à jour lesde champ. 

Pour mettre à jour manuellement votre table des matières, consultez Mettre à jour une table des matières. 

Si vous avez des entrées manquantes 

Les entrées manquantes se produisent souvent parce que les titres ne sont pas mis en forme en tant que 

titres. 

1. Pour chaque titre que vous souhaitez dans la table des matières, sélectionnez le texte du titre. 

2. Accédez à Accueil > Styles, puis choisissez Titre 1. 

 

3. Mettez à jour votre table des matières. 

Pour mettre à jour manuellement votre table des matières, consultez Mettre à jour une table des matières. 

Créer la table des matières 

https://support.microsoft.com/fr-fr/office/mettre-%C3%A0-jour-une-table-des-mati%C3%A8res-6c727329-d8fd-44fe-83b7-fa7fe3d8ac7a
https://support.microsoft.com/fr-fr/office/mettre-%C3%A0-jour-une-table-des-mati%C3%A8res-6c727329-d8fd-44fe-83b7-fa7fe3d8ac7a
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Word utilise les titres de votre document pour générer une table des matières automatique qui peut être 

mise à jour lorsque vous modifiez le texte, l’ordre ou le niveau du titre. 

1. Cliquez à l’endroit où vous souhaitez insérer la table des matières, en général vers le début du 

document. 

2. Cliquez sur Références > Table des matières, puis choisissez un style de Table des matières 

automatique dans la liste. 

Remarque : Si vous utilisez un style de Table des matières manuel, Word n’utilise pas vos titres pour 

créer une table des matières et ne peut pas effectuer de mise à jour automatique. À la place, Word utilise 

le texte des espaces réservés pour créer l’apparence d’une table des matières. Vous pouvez ainsi taper 

manuellement chaque entrée dans la table des matières. Pour mettre à jour votre table des matières 

manuelle, consultez Mettre à jour une table des matières. 

 

https://support.microsoft.com/fr-fr/office/mettre-%C3%A0-jour-une-table-des-mati%C3%A8res-6c727329-d8fd-44fe-83b7-fa7fe3d8ac7a


12 

Itec/MODR 2915 

12 | P a g e  

 

Vous pouvez mettre en forme ou personnaliser votre table des matières. Par exemple, vous pouvez 

modifier la police, le nombre de niveaux de titre et l’affichage de pointillés entre les entrées et les 

numéros de page. 

Si vous avez des entrées manquantes 

Les entrées manquantes se produisent souvent parce que les titres ne sont pas mis en forme en tant que 

titres. 

1. Pour chaque titre que vous souhaitez dans la table des matières, sélectionnez le texte du titre. 

2. Accédez à Accueil > Styles, puis choisissez Titre 1. 

 

3. Mettez à jour votre table des matières. 

Pour mettre à jour manuellement votre table des matières, consultez Mettre à jour une table des matières. 

Word utilise les titres de votre document pour générer une table des matières automatique qui peut être 

mise à jour lorsque vous modifiez le texte, l’ordre ou le niveau du titre. 

1. Cliquez à l’emplacement où vous souhaitez insérer la table des matières, généralement au début 

du document. 

2. Dans le ruban de la barre d’outils, sélectionnez Références.  

3. Près de l’extrémité gauche, sélectionnez Insérer une table des matières. (Ou sélectionnez 

Table des matières > Insérer une table des matières.  

La table des matières est insérée, affichant les titres et la numérotation des pages dans votre document. 

Si vous apportez des modifications à votre document qui affectent la table des matières, vous pouvez la 

mettre à jour en cliquant avec le bouton droit sur la table et en sélectionnant Mettre à jour la table des 

matières. 

Voir aussi 

Mettre à jour une table des matières  

 

  

https://support.microsoft.com/fr-fr/office/mettre-en-forme-ou-personnaliser-une-table-des-mati%C3%A8res-9d85eb9c-0b55-4795-8abb-a49885b3a58d
https://support.microsoft.com/fr-fr/office/mettre-%C3%A0-jour-une-table-des-mati%C3%A8res-6c727329-d8fd-44fe-83b7-fa7fe3d8ac7a
https://support.microsoft.com/fr-fr/office/mettre-%C3%A0-jour-une-table-des-mati%C3%A8res-6c727329-d8fd-44fe-83b7-fa7fe3d8ac7a
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support.microsoft.com  

Question 8 Mettre à jour une table des matières 

~2 minutes 

 

Word pour Microsoft 365 Word pour Microsoft 365 pour Mac Word pour le web Word 2021 

Word 2021 pour Mac Word 2019 Word 2019 pour Mac Word 2016 Word 2016 pour Mac 

Word 2013 Word 2010 Plus...Moins 

1. Allez à Références >Mettre à jour la table. 

 

2. Sélectionnez l’une des options suivantes : 

o Mettre à jour les numéros de page uniquement    Cette modification met 

uniquement à jour les pages sur les titres et ignore les modifications apportées au 

texte du titre.  

o Mettre à jour l'intégralité de la table    Cela reflète toutes les mises à jour apportées 

au texte du titre, ainsi que toutes les modifications apportées aux pages.  

3. Sélectionnez OK.  

Remarque : Les tableaux créés manuellement (qui ne sont pas créés automatiquement à partir des 

titres) ne peuvent pas être mis à jour par Word. Vous devrez taper manuellement vos 

modifications dans la table des matières. 

 

 

 

 

https://support.microsoft.com/fr-fr/office/mettre-%C3%A0-jour-une-table-des-mati%C3%A8res-6c727329-d8fd-44fe-83b7-fa7fe3d8ac7a

